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2 INTRODUCTION 
 
This Release Notes document explains the changes between the previous software version 
and the current software version that are not explained in the Reference Manual. 

To get the best out of GrandVJ, please ensure that you are using the latest software version; 
you can download it from www.arkaos.net 
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3 WHATʼS NEW IN GRANDVJ 
 
 

3.1 Interface changes 

3.1.1 Dark theme 

GrandVJ can now be used either with the original “white” skin or with a darker skin to 
accommodate darker working conditions. 
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The interface theme can be 
switched by accessing the 
advanced tab in the 
Preferences dialog.  
Note that changing the interface 
theme will require restarting the 
application. 

 

 

 

 

 

 

3.1.2 Slider enhancement 

All sliders have been updated to provide better control: 

• The tool tip is reflecting the value of the slider and stays on while modifying the 
slider's value 

• Sliders can be modified using the mouse wheel (by 1% steps) 
• Pressing Alt (Mac) or Shift (Windows) while using the mouse wheel will give change 

the value with 0.1% steps 
• Pressing shift while moving the sliders rounds the value to 0.1% accuracy 
• Alt + Click (Mac) or Ctrl + Click (Windows)  resets the slider to it's default value 

 

3.2 Enhanced mixer mode 

In mixer mode, GrandVJ has now the possibility of assigning 
each layer to either the 'A' or 'B' deck. This is done by 
pressing the 'A' or 'B' sign on each side from the layer 
preview: 

When a layer is assigned to either A or B, it's effective 
transparency is going to be the combination of the layer's 
transparency transparency setting and the position of the 
cross fader (located under the layer previews). When the 
cross fader is all the way to the left (on the A side), layers 
assigned to 'A' will be fully visible while layers assigned to 'B' 
will be invisible. On the other hand, when the cross fader is 
all the way to the right, all layer assigned to B will be fully 
visible while layers associated to A will be hidden 

This scheme allows to smoothly go from one stack of visuals 
assigned to Deck A to the stack of visuals assigned to Deck B 
using the cross fader. You can also leave layers 'unassigned' 
which mean their transparency level will be independent of 
the cross fader. The 2 A & B buttons on each side of the 
cross fader allow to cut rapidly to full A and full B 
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3.2.1 Independent preview 

When assigning layers to either A or B, you have the possibility to use the master preview to 
display the output (as before) but also to preview only the layers assigned to either deck A or B. 
Suppose you are outputting the content of deck A (by setting the cross fader all the way to the 
left). If you toggle the preview to deck B, you can now set it up without interrupting the main 
output. When you are satisfied by what is on deck B, flip back the preview to the main output 
(pressing B again) and use the cross fader to go smoothly from A to B. 

 

3.3 Improved visual files support 

3.3.1 Alpha channel support 

GrandVJ now provides support for Alpha channel in images and videos. This means that if you 
import videos that have transparency information, this information will be used in the graphical 
pipeline for blending and effects. GrandVJ fully supports QuickTime PNG & QuickTime 
Animation CODECs as well as transparent PNG & BMP files. 

3.3.2 Support for FFMpeg H.264 decoding 

GrandVJ is now integrating FFMpeg 0.5 which allows native support for H.264 & AVCHD. 
Please be aware that AVCHD is still in very early stages and some files might lead to memory 
leaks. 

 

3.4 Controller mapping 

3.4.1 Mapping templates 

GrandVJ supports  the ability  to define and save 
mapping  templates so  that  you can define various 
controller combinations and recall them on  the  fly. 
When starting  the program,  If you choose new... in 
the startup dialog, you will be presented with a 
dialog allowing you to choose which template to use. 

GrandVJ comes with a handful of templates allowing  
to work with several controllers from different 
vendors as well as various combinations of blank, 
keyboard controlled and GrandVJ specific  
mappings. For some keyboards and controllers, we 
provide files that will allow to upload the midi 
configuration corresponding to the GrandVJ 
template.  

See the 'Template' folder in the installation directory and refer to your MIDI controller 
documentation for information on how to upload the configuration to your keyboard. 
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3.4.2 Using custom templates 

From within GrandVJ, it is easy to create new 
templates, modify existing ones or share templates 
with other people.  

To create your own template, simply do all your midi 
and keyboard assignment and select the menu  
File > Save mapping template. 

In the dialog, you can choose to either create a new 
template (in which case you will need to specify a 
template name and a description) or update an 
existing template. 

All the saved templates will be available at startup. 

 

To load or manage your template set, choose the 
menu File > Load Mapping Template. This will open 
the “Choose mapping template” dialog. 

To make a mapping active, simply select a template 
from the list and click the Ok button. 

Alternatively, you can also reset all templates to the 
factory settings or import a template that has been 
given  to you as .vjt file.  

You can also right click on any entry to delete it, edit 
its name/description or export the template 
definition to a separate .vjt file. 

 

 

 

3.4.3 Mapping dialog 

The keyboard and midi mapping dialog now provide 
numeric feedback of the slider values. Values can 
also be entered directly using the text fields. 
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3.4.4 Templates for Korg Nano & Hercules DJ controllers 

Korg Nano MIDI mapping templates  
 

• Nano PAD + Nano KONTROL  
• NanoKEY + Nano KONTROL  

 
Hercules DJ MIDI mapping templates  
 

• Hercules DJ Console MP3  
• Hercules DJ Console MK2  
• Hercules DJ Control STEEL  
• Hercules DJ Control RMX  

 
Note: If you upgrade a previous version of the software, you will need to erase your mapping 
file if you want the new templates to be displayed. 

3.4.5 Open sound control mapping 

In addition to MIDI and Keyboard control, GrandVJ 
can now also be controlled through Open Sound 
Control (or OSC). OSC is a new emerging protocol 
that is networked (so it works through regular wired 
or wireless tcp/ip) and a lot more precise than MIDI. 
There are more and more applications coming up 
that supports this protocol, especially in the mobile 
field on devices like the iPhone. 

The same way GrandVJ listens to MIDI, it can also 
listen to the network for OSC messages. Any control 
can be mapped to any OSC address for remote 
control. 

Since it is a network protocol, you will have to define 
on which port GrandVJ needs to listen. This is done 
in the Preferences Dialog, in the OSC tab. 

To assign a control to an OSC control, simply toggle the application in OSC mapping (Menu 
Options>Edit Osc Mapping), select with the mouse the control you would like to map and send 
OSC messages from the remote application.  

Once it is mapped, you will see the mapping address looking like a path on the key itself. for 
example: 

/2/push1 
 

All OSC communication is done using referring path-like addresses. Each address represent a 
node that can be controlled. GrandVJ expects the controlling application to supply values 
between 0.0 and 1.0. 

If your controlling application sends more than one value per address (for example a X-Y touch 
pad could send one value for X and on for Y using a single address), you will need to enter the 
address by hand.  
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To do so, right click on the control you would like to map and select Osc Mapping... 

 
 

You can there enter any address that you would like. If you want to specify the second value of 
the address (e.g. for the XY pad example we talked about) specify a comma followed by the 
number of the parameter after the address. 

Note for iPhone users: if you use an iPhone (with for example mrmr, TouchOSC, ...), please 
deactivate the accelerometer during the "OSC learn" phase, otherwise the iPhone will send a 
lot of accelerometer values and you won't be able to assign messages other than the 
accelerometer controls. 

 

3.5 MIDI reference for template mapping 

3.5.1 Introduction 

Additionally to custom made templates for existing controllers, the template library contains two 
templates that expose all of the controllable parameters available in mixer mode.  

The first one, GrandVJ Full  Mixer  Mode, maps all the layer parameters in full mode (I.e.  You 
control all layers  independently).  

The second one, GrandVJ Selected Mixer Mode, maps all the layer parameters in 'selected 
mode', i.e. you always control the selected layer (see the Reference Manual for more 
information about the difference between the two modes).  

This section lists the MIDI assignment of those two templates 

3.5.2 GrandVJ Full Mixer Mode 

Layer Parameter  Midi CC  Channel 

Visual Next  0 1-8 

Visual Previous  1  1-8 

Loop Mode  2 1-8 

Movie Speed  3 1-8 

Loop Start  4 1-8 

Loop Length  5 1-8 

Transparency  6 1-8 

Copy Mode  7 1-8 

Mask Mode  8 1-8 

Mask Center  9 1-8 

Mask Width  10 1-8 

Mask Smooth  11 1-8 

Red  12 1-8 
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Layer Parameter  Midi CC  Channel 

Green  13  1-8 

Blue  14  1-8 

Mixing Preset  15 1-8 

Effect Next  16 1-8 

Effect Previous  17 1-8 

Effect Parameter 1  18 1-8 

Effect Parameter 2  19 1-8 

Effect Parameter 3  20 1-8 

Effect Parameter 4  21 1-8 

Position X  22 1-8 

Position Y  23 1-8 

Position Z  24  1-8 

Size X  25 1-8 

Size Y  26 1-8 

Rot X  27 1-8 

Rot Y  28 1-8 

Rot Z  29 1-8 

Rotation Mode X  30 1-8 

Rotation Mode Y  31 1-8 

Rotation Mode Z  32 1-8 

Shape  33 1-8 

Tiling  34 1-8 

Position Preset  35  1-8 

Deck A Select 125 1-8 

Deck B Select 126 1-8 
 

Layer Control  Midi CC  Channel 

Layer Next  36  1 

Layer Previous  37 1 

Layer Select (continuous)  38 1 

Layer 1 Select  39 1 

Layer 2 Select  40 1 

Layer 3 Select  41 1 

Layer 4 Select  42 1 
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Layer Control  Midi CC  Channel 

Layer 5 Select  43 1 

Layer 6 Select  44 1 

Layer 7 Select  45 1 

Layer 8 Select  46 1 

Layer 1 Pause  48 1 

Layer 2 Pause  49 1 

Layer 3 Pause  50 1 

Layer 4 Pause  51 1 

Layer 5 Pause  52 1 

Layer 6 Pause  53 1 

Layer 7 Pause  54 1 

Layer 8 Pause  55 1 

Layer 1 Clear  57 1 

Layer 2 Clear  58 1 

Layer 3 Clear  59 1 

Layer 4 Clear  60 1 

Layer 5 Clear  61 1 

Layer 6 Clear  62 1 

Layer 7 Clear  63 1 

Layer 8 Clear  64 1 
 

Bank Control Midi CC  Channel 

Matrix Bank Next  65 1 

Matrix Bank Previous  66 1 

Matrix Bank Select (continuous)  67 1 

Matrix Bank 1 Select  68 1 

Matrix Bank 2 Select  69 1 

Matrix Bank 3 Select  70 1 

Matrix Bank 4 Select  71 1 

Matrix Bank 5 Select  72 1 

Matrix Bank 6 Select  73 1 

Matrix Bank 7 Select  74 1 

Matrix Bank 8 Select  75 1 

Matrix Bank 9 Select  76 1 
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Bank Control Midi CC  Channel 

Matrix Bank 10 Select  77 1 

Matrix Bank 11 Select  78 1 

Matrix Bank 12 Select  79 1 

Matrix Bank 13 Select  80 1 

Matrix Bank 14 Select  81 1 

Matrix Bank 15 Select  82 1 

Matrix Bank 16 Select  83 1 

Keyboard Bank Next  84 1 

Keyboard Bank Previous  85 1 

Keyboard Bank Select (continuous)  86 1 

Keyboard Bank 1 Select  87 1 

Keyboard Bank 2 Select  88 1 

Keyboard Bank 3 Select  89 1 

Keyboard Bank 4 Select  90 1 

Keyboard Bank 5 Select  91 1 

Keyboard Bank 6 Select  92 1 

Keyboard Bank 7 Select  93 1 

Keyboard Bank 8 Select  94 1 

Keyboard Bank 9 Select  95 1 

Keyboard Bank 10 Select  96 1 

Keyboard Bank 11 Select  97 1 

Keyboard Bank 12 Select  98 1 

Keyboard Bank 13 Select  99 1 

Keyboard Bank 14 Select  100 1 

Keyboard Bank 15 Select  101 1 

Keyboard Bank 16 Select  102 1 
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General Controls Midi CC  Channel 

Latch  103 1 

Hold  104 1 

Clear All Layers  105 1 

Input Volume  106 1 

Contrast  107 1 

Brightness  108 1 

Cross fader 120 1 

Cross fader Full A 121 1 

Cross fader Full B 122 1 

Preview Deck A Assign 123 1 

Preview Deck B Assign 124 1 
 

3.5.3 GrandVJ Selected Mixer Mode 

Layer Parameter  Midi CC  Channel 

Visual Next 0 1 

Visual Previous 1 1 

Loop Mode 2 1 

Movie Speed 3 1 

Loop Start 4 1 

Loop Length 5 1 

Transparency 6 1 

Copy Mode 7 1 

Mask Mode 8 1 

Mask Center 9 1 

Mask Width 10 1 

Mask Smooth 11 1 

Red 12 1 

Green 13 1 

Blue 14 1 

Mixing Preset 15 1 

Effect Next 16 1 

Effect Previous 17 1 

Effect Parameter 1 18 1 

Effect Parameter 2 19 1 
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Layer Parameter  Midi CC  Channel 

Effect Parameter 3 20 1 

Effect Parameter 4 21 1 

Position X 22 1 

Position Y 23 1 

Position Z 24 1 

Size X 25 1 

Size Y 26 1 

Rot X 27 1 

Rot Y 28 1 

Rot Z 29 1 

Rotation Mode X 30 1 

Rotation Mode Y 31 1 

Rotation Mode Z 32 1 

Shape 33 1 

Tiling 34 1 

Position Preset 35 1 

Deck A Select 118 1 

Deck B Select 119 1 
 

Layer Control  Midi CC  Channel 

Layer Next 36 1 

Layer Previous 38 37 1 

Layer Select (continuous) 38 1 

Layer 1 Select 39 1 

Layer 2 Select 40 1 

Layer 3 Select 41 1 

Layer 4 Select 42 1 

Layer 5 Select 43 1 

Layer 6 Select 44 1 

Layer 7 Select 45 1 

Layer 8 Select 46 1 

Pause Selected Layer 47 1 

Layer 1 Pause  48 1 

Layer 2 Pause 49 1 



16 
 

 

 

Layer Control  Midi CC  Channel 

Layer 3 Pause 50 1 

Layer 4 Pause 51 1 

Layer 5 Pause 52 1 

Layer 6 Pause 53 1 

Layer 7 Pause 54 1 

Layer 8 Pause 55 1 

Clear Selected Layer 56 1 

Layer 1 Clear 57 1 

Layer 2 Clear 58 1 

Layer 3 Clear 59 1 

Layer 4 Clear 60 1 

Layer 5 Clear 61 1 

Layer 6 Clear 62 1 

Layer 7 Clear 63 1 

Layer 8 Clear 64 1 

Layer 1 Transparency 109 1 

Layer 2 Transparency 110 1 

Layer 3 Transparency 111 1 

Layer 4 Transparency 112 1 

Layer 5 Transparency 113 1 

Layer 6 Transparency 114 1 

Layer 7 Transparency 115 1 

Layer 8 Transparency 116 1 

Layer 1 Deck A Select 125 1 

Layer 1 Deck B Select 126 1 

Layer 2 Deck A Select 125 2 

Layer 2 Deck B Select 126 2 

Layer 3 Deck A Select 125 3 

Layer 3 Deck B Select 126 3 

Layer 4 Deck A Select 125 4 

Layer 4 Deck B Select 126 4 

Layer 5 Deck A Select 125 5 

Layer 5 Deck B Select 126 5 

Layer 6 Deck A Select 125 6 



17 
 

 

 

Layer Control  Midi CC  Channel 

Layer 6 Deck B Select 126 6 

Layer 7 Deck A Select 125 7 

Layer 7 Deck B Select 126 7 

Layer 8 Deck A Select 125 8 

Layer 8 Deck B Select 126 8 
 

Bank Control Midi CC  Channel 

Matrix Bank Next 65 1 

Matrix Bank Previous 66 1 

Matrix Bank Select (continuous) 67 1 

Matrix Bank 1 Select 68 1 

Matrix Bank 2 Select 69 1 

Matrix Bank 3 Select 70 1 

Matrix Bank 4 Select 71 1 

Matrix Bank 5 Select 72 1 

Matrix Bank 6 Select 73 1 

Matrix Bank 7 Select 74 1 

Matrix Bank 8 Select 75 1 

Matrix Bank 9 Select 76 1 

Matrix Bank 10 Select 77 1 

Matrix Bank 11 Select 78 1 

Matrix Bank 12 Select 79 1 

Matrix Bank 13 Select 80 1 

Matrix Bank 14 Select 81 1 

Matrix Bank 15 Select 82 1 

Matrix Bank 16 Select 83 1 

Keyboard Bank Next  84 1 

Keyboard Bank Previous 85 1 

Keyboard Bank Select (continuous) 86 1 

Keyboard Bank 1 Select 87 1 

Keyboard Bank 2 Select 88 1 

Keyboard Bank 3 Select 89 1 

Keyboard Bank 4 Select 90 1 

Keyboard Bank 5 Select 91 1 
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Bank Control Midi CC  Channel 

Keyboard Bank 6 Select 92 1 

Keyboard Bank 7 Select 93 1 

Keyboard Bank 8 Select 94 1 

Keyboard Bank 9 Select 95 1 

Keyboard Bank 10 Select 96 1 

Keyboard Bank 11 Select 97 1 

Keyboard Bank 12 Select 98 1 

Keyboard Bank 13 Select 99 1 

Keyboard Bank 14 Select 100 1 

Keyboard Bank 15 Select 101 1 

Keyboard Bank 16 Select 102 1 
 

General Controls Midi CC  Channel 

Latch 103 1 

Hold 104 1 

Clear All Layers 105 1 

Input Volume 106 1 

Contrast 107 1 

Brightness 108 1 

Cross fader 120 1 

Cross fader Full A 121 1 

Cross fader Full B 122 1 

Preview Deck A Assign 123 1 

Preview Deck B Assign 124 1 
 

 



 

 



 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 

 


